
 

 

 

 

 

 

2023 LABMA Conference 

 



 



zzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzzz    

This Photo by 

Unknown 

Author is 

licensed under 

CC BY-NC 

Introduction 

Organizing your Area  

Organizing your Apps 

Taking a shortcut... 

What-Why ACP 

Consider the Re-Source 

To Keep or not to Keep 

...and one more thing 

 

https://pngimg.com/download/60463
https://creativecommons.org/licenses/by-nc/3.0/


 

Office management is important because it can help you use working hours more efficiently, 
increase employee productivity and enhance the company's quality of work. Using strong office 
management strategies and techniques can also help you develop powerful administrative 
skills, create a constructive working atmosphere and boost employee morale. 

Here are some suggested ways to achieve your goal: 

1. Organize your space - Having a clean environment can help eliminate distractions and 
improve work performance.  Creating an organized space improves team efficiency. A few 
suggestions to help accomplish this are: 

• Creating established work zones for employees 
• Updating company filing systems 
• Labeling shelves, drawers and cubbies 
• Sorting completed project documents into storage 

boxes and files 
• Keeping a re-supply list (printer ink, staplers, etc.) 

2. Keep updated records - Maintaining updated 
company records can be a crucial step in managing your office. Current contacts information, 
updated schedules and the weekly ‘to do’ list can save your office time and help your team 
perform their duties more effectively. 

3. Schedule out your week - Scheduling out your week can help you manage your time more 
efficiently and prioritize your work. At the beginning of the week, look over your deadlines, 
meetings and other important duties you need to complete within that week and sort them 
based on priority. When sorting, consider using these categories: 

• Stationary: Meetings or tasks that have a set date, are often already scheduled, and can't 
be moved easily. Fill in all your stationary responsibilities first and schedule your other 
tasks around them. 

• Top Priority: Meetings or tasks that you need to complete on certain days by the end of 
the week. Sort these assignments by their deadlines so that you can finish them in order 
of importance. 

• Flexible: These are the last assignments you put on your schedule. They are often tasks 
that don't have to be completed by the end of the week but may contribute to another 
project or deadline in the near future. These can be worked in as time permits. 

By sorting your information and creating a weekly schedule, you can better understand what 
you can realistically accomplish within one week and if you need to adjust project goals, 
delegate work or request deadline extensions. 



 

4. Delegate tasks - Delegating tasks to other individuals can help boost the performance and 
productivity of your office while helping you meet important deadlines. For example, if you 
have a large project that you need to complete in a short amount of time, consider assigning 
small portions of that project to different team members. They can complete all those small 
assignments simultaneously and then allow you to compile the work and information into one 
cohesive document or report after they're done. 

5. Establish routines - Creating established routines in an office space can help manage 
workflow, create systems for processing client information and allowing for certain 
emergencies. When an individual or team member completes their assigned duties or tasks, it 
can be helpful to have a task list to review for the next priority.  This will help create a self-
sufficient workflow that allows a team to work consistently throughout the day while freeing up 
your own time to work on your own tasks and projects. 

6. Eliminate distractions - Eliminating distractions can also help create a productive work 
atmosphere, help increase work performance and eliminate unnecessary distractions from the 
office. It can also be helpful to set timers for yourself to focus on work. Completing work in 30-
to-45-minute segments while taking a quick break in-between can boost your work rate and 
help you complete more tasks throughout the day. 

Some other great ways to reduce distractions in 
the workplace include: 

• Turning off notifications on your phone 
• Setting your phone to gray scale to reduce 

its appeal 
• Wearing noise-canceling headphones when 

appropriate 
• Schedule specific times throughout the day to check your email 

7. Define roles and responsibilities - When employees and individuals understand their roles 
and responsibilities within a company, it can help them know which assignments and tasks they 
need to complete and finish their daily work more efficiently. Regularly evaluate your primary 
duties with staff. This can make sure everyone is on track and can also let all know if their duties 
have expanded or changed since the last evaluation. 

8. Encourage further training and development - Encouraging your team members to 
continue developing and providing them with further training opportunities can help improve 
your office morale and increase employee performance. Allowing employees to improve their 
occupational skills and knowledge can help them conduct their work more efficiently and 
enhance the quality of their deliverables. 



 
  

Example of my Quick Access Toolbar from three of my applications 

 

• Setup a Quick Access Toolbar in each your office applications with the same layout: 

 

 

 

 

 

 

 

The customizable Quick Access Toolbar contains a set of commands that are independent of the currently 

displayed tab on the ribbon. You can move the Quick Access Toolbar from one of the two possible locations, 

and you can add buttons that represent commands to the Quick Access Toolbar.  

 

 

 

 

 

To setup up the toolbar, click 

the dropdown on the end of 

the toolbar: 

Select the items you want on 

the toolbar by checking from 

the menu or by selecting 

More Commands at the 

bottom and choose the additional 

commands you want to see displayed.  You can also change the layout order from 

this location. 

For more information and options related to the Quick Access Toolbar click HERE. 

 

• Create Shortcut keys to commonly needed tasks: 

For detail information and options related to the Creating Shortcut keys click HERE. 

Shortcut keys can also be setup (in Word) for 

frequently used Symbols. To setup, go to the Insert 

tab, select Symbols, find the symbol you use, select 

the Shortcut Key button, apply a shortcut key 

preference and save.  

Quick Access Toolbar 

Ribbon 

Tabs 

https://support.microsoft.com/en-us/office/customize-the-quick-access-toolbar-43fff1c9-ebc4-4963-bdbd-c2b6b0739e52#:~:text=1%20On%20the%20ribbon%2C%20click%20the%20appropriate%20tab,Access%20Toolbar%20on%20the%20shortcut%20menu.%20See%20More
https://support.microsoft.com/en-us/office/customize-keyboard-shortcuts-9a92343e-a781-4d5a-92f1-0f32e3ba5b4d


 
  
 

• Customize Your Ribbon or Create Your Own Ribbon: 

You can personalize your ribbon to arrange tabs and commands in the order you want them, hide or unhide 

your ribbon, and hide those commands you use less often. Also, you can export or import a customized ribbon. 

 

 

 

 

 

 

 

If mostly work on one Ribbon (ie. Home) but you have frequently use a tasks from another Ribbon, you can 

customize that Ribbon to add the frequently used task. Or if you prefer, you can create your very own 

Customized Ribbon that only contains the tasks you want.   

Note:  Your customizations apply only to the Office program you're working in at the time.  If you want similar 

customizations in your other Office apps, you'll have to open each of those apps to make the same changes. Although you 

can't share customizations between apps, you can export your customizations to share with others or use on other 

devices. 

For more information and options related to the Customizing your Ribbons click HERE. 

• Organize Your Browser: 

Create a tab group: 

• Choose one of the tabs that you want to include in a group — any will do — and right-click on it. 

• Select Add Tab to Group > New Group 

• Type in the name of the new group, choose a color, and hit Return. 

 

 

 

 

 

 

 

 

 

Additional options, using frequent site location tools allow you to save and organize tabs that you don’t need everyday 

but refer to often.  The Microsoft Edge tool called ‘Collections’ is native, while Chrome has an add-on file extension 

called ‘OneTab’. Both are easy to set up and use to help clear out the clutter of your browser. 

Before Groups 

After Groups 

https://support.microsoft.com/en-us/office/customize-the-ribbon-in-office-00f24ca7-6021-48d3-9514-a31a460ecb31#:~:text=Customize%20Ribbon%20in%20Excel%201%20To%20customize%20the,the%20add%20or%20remove%20arrows.%20.%20See%20More
https://support.microsoft.com/en-us/microsoft-edge/organize-your-ideas-with-collections-in-microsoft-edge-60fd7bba-6cfd-00b9-3787-b197231b507e
https://chrome.google.com/webstore/detail/onetab/chphlpgkkbolifaimnlloiipkdnihall?hl=en


Ctrl+X  Cut selected text.

Ctrl+C  Copy selected text.

Ctrl+V  Paste text at cursor.

Ctrl+Z Undo.

Ctrl+Y Redo.

Home Move cursor to beginning of current line.

End Move cursor to end of current line.

Ctrl+Home Move cursor to top of the text entry field.

Ctrl+End Move cursor to bottom of the text entry field.

Page Up Move cursor to bottom of the text entry field.

Page Down Move cursor down a frame.

Ctrl+Left Arrow Move cursor to beginning of previous word.

Ctrl+Backspace Delete previous word.

Ctrl+Delete Delete next word.

Ctrl+Up Arrow Move cursor to beginning of paragraph.

Ctrl+Down Arrow Move cursor to end of paragraph.

Ctrl+A Select all text.

Shift+Left or Right Arrow  Select characters one at a time.

Shift+Up or Down Arrow  Select lines one at a time.

Shift+Ctrl+Left or Right Arrow  Select words – keep pressing the arrow keys to select additional words.

Shift+Ctrl+Up or Down Arrow  Select paragraphs.

Shift+Home Select the text between the cursor and the beginning of the current line.

Shift+End Select the text between the cursor and the end of the current line.

Shift+Ctrl+Home 
Select the text between the cursor and the beginning of the text entry field.

Shift+Ctrl+End Select the text between the cursor and the end of the text entry field.

Shift+Page Down Select a frame of text below the cursor.

Shift+Page Up Select a frame of text above the cursor.

Ctrl+B Bold.

Ctrl+I Italic.

Ctrl+U Underline.

Ctrl+F Opens Find dialog box

F3 Find next.

Shift+F3 Find previous.

Ctrl+O Open.

Ctrl+S Save.

Ctrl+N New document.

Ctrl+P Print.

Alt 

Activates the menu bar. Use the arrow keys to select a menu option and the 

Enter key to activate it.

Alt+F Open File menu.

Alt+E+E Open Edit menu.

Alt+V+V Open View menu.

Menu Functions

Formatting shortcuts only work if the application or website you’re using supports text formatting. If you have text selected the shortcut will apply the 

formatting to your selected text. If you don’t have text selected the shortcut will toggle the associated formatting option.

Note: These shortcuts are for PC users.  Mac users often can use substitue the                                                                                                       

         Option key for the Control key but should search for Mac specific shortcut keys

Editing Text or document

Moving the Cursor

Selecting Text or moving within the body of a document

Formatting Text



Shortcut Keys Description

Windows + Shift + S Opens Snip tool (Snip & Sketch)

Windows Opens/closes the Start menu.

Windows + L Locks the screen.

Windows + V Opens Clipboard History.

Windows + Q Opens Windows Search.

Windows + E Opens File Explorer.

Windows + H Opens the dictation toolbar. (Some initial setup required to use.)

Windows + M Minimizes all open windows.

Windows + Shift + M Opens minimized windows.

Windows + Up Arrow Maximizes the selected window.

Windows + Down Arrow Reduces the window size. (Restore down.)

Windows + .  or Windows + ; Opens the emoji panel.  👌😍😂🤣😘😁😎😆🎶🎁✨

Windows + Tab Shows Task View.  

Windows + Control + D Creates a virtual desktop.

Windows + Control + Right Arrow Switches to the virtual desktop on the right.

Windows + Control + Left Arrow Switches to the virtual desktop on the left.

Windows + Control + F4 Closes the active virtual desktop.

Windows + Print Screen (may need 

Function key)
Takes a screenshot of the desktop.

Windows + P Opens the projection settings.

Windows + <number>
Opens the app in the taskbar relative to the number input.  (For 

example, if Word is the fourth app on the taskbar, using Windows Key + 4 will 

open Word.)

Windows + Alt + <number>

Opens the right-click menu for the app in the taskbar relative to the 

number input.   (For example, if Word is the fourth app on the taskbar, using 

Windows Key + Alt + 4 will open Word's right-click menu.)

Windows + D Shows/hides open apps on the desktop.

Windows + Space Switches between installed languages (for writing text).

Windows + I (the i key) Opens the Settings menu.

Windows + G Open the Xbox Game Bar

Windows + K Open the Connect sidebar

Windows + R Open the “Run” window

Windows + S Open Search

Windows + Left Snap current window to the left side of the screen.

Windows + Right Snap current window the the right side of the screen.

Windows + Up Snap current window to the top of the screen.

Windows + Down Snap current window to the bottom of the screen.

Symbol / Description Shortcut keys

    ¢   / cent symbol Alt  key + 0162  OR  Cntl key + /C

   °   / degree symbol Alt  key + 0176
   ✓ / checkmark Alt  key + 0252 then select and choose Wingding font

    / checkmark in  box Alt  key + 0254 then select and choose Wingding font

Note: all symbol characters can be added by going through the Insert Ribbon, selecting Symbols, then scroll to find the correct figure you want.  The 

purpose of this list is just offer a keyboard shortcut alternative. In Word, you can assign shortcut keys to often used symbols.

Symbol shortcuts



 
 

Do you know what ACP is? Annual Church Profile 

Filling out an ACP has become passe’ to some. Churches increasingly don’t see the 

importance or need for recording and/or sharing their yearly information. 

Arguments range from – I’m not about numbers, I am about reaching people – It’s just a 

competition, and I have no interest in competing with my fellow churches – It’s no one’s 

business but our church’s and we don’t need to share it – or even – I don’t want the 

federal government/IRS to know our business (too late on this last one). Who Cares?? 

Well, God cares!  Throughout the Bible, God is continually instructing his people to take 

a count, write it down, record it for generations to come.  And we care - we care what is 

going on in your church. How you are doing and what needs you may have.  Dr. Horn 

has often asked our churches to share all about their activities and what is happening.  

We want to celebrate your victories, pray with you over any challenges, and partner 

with you to find ways to reach those who need Jesus. …Let us know your story! 

ACP is one of the vehicles that helps us to do that.  It is your ‘story’ – your ‘testimony’. 

SBC is the world’s largest Baptist denomination; it’s also the largest Protestant and 

second largest Christian denomination in the U.S. (2nd behind Catholic).   

Since its beginning in 1845 there has always been some form of information collection 

from the churches. At its beginning, there were 350,000 members of the SBC. As of 

2021 statistics the membership level is 13,680,493. That is actually trending down 

over the past few years.  

But my question is – are there more? When a church does not report they are not 

represented in that number, and this has a multi-dimensional impact. 

 

Imagine trying to bake a cake with 20% of the recipe missing. It is not practical and 

therefore not accurately possible. That is what we have with ACP reporting. In 

Louisiana, only 80% of our churches are reporting. Of that number, 30-35% only 

report minimal info (approximately 3 statistics). Imagine if you had to do a report on a 

book and 20% of it was missing and of the part you did have, 30-35% was just 

chapter headings without content. It would make reporting very difficult and 

incomplete. 

So, you see how reporting every year is important. And we offer tools to help you 

accomplish successfully reporting every year with as little “pain” as possible. One of 

those tools I have included with this booklet. There is a worksheet (weekly and 

monthly) that you can record key statistics through the year, and it will calculate ACP 

totals for you. All you do at the end of the year is record those totals to the report. Also, 

Leadership is open all year long so as leaders changes, or move or get a new phone or 

email, you can record that when it happens.  That way you don’t have ALL of it to do at 

the end of the year. 



 
Know well the condition of your flock, and pay attention to your herds. 

Proverbs 27:23 (CSB) 

 

BENEFITS EQUAL COOPERATION YIELDS 
 

 

COMPLETE YOUR ACP 

Go to www.sbcworkspace.com. 

If you forgot your username and password, contact your state convention office, and ask for it. 

or you may complete the mailed ACP form. 

 

 

 

 
FUTURE 

insights for planning the future. 

 

to better lead you into the future. 

 
PRESENT 

(Matthew 18:12–14) 

 

PAST 

(Joshua 4:1–7) 

to teach the generations. 

 

OPPORTUNITIES 

 

 

 
 

ELEVATION 

 

 

ENCOURAGEMENT 

 

and good news about kingdom work. 

http://www.sbcworkspace.com/


 
 Website Resources 

 

*Note: There are two obvious omissions from this list – Microsoft 365 and Google Suites.  Those are both 
great tools and are capable of many of the software options here.  This list is not meant to serve as a 
complete listing or as a recommendation but simply a list of products either mentioned during training or 
referenced in research or used by our office. It is recommended that you explore and review any product 
you want to invest in/purchase.  You are the best judge of what will work for your situation. 

 
Links for Louisiana Baptist life: 
1. LaOne (AKA sbcworkspace.com)– site for church lookup, entering ACP report information, 

registering for LBC Annual meeting.   
2. LouisianaBaptists – information on Events, Churches, Resources, et al for LA churches. 

a. Louisiana Baptist Ministry links 
b. Tall Timbers Conference Center – state conference center 
c. Baptist Message – LA Baptist state paper 

d. Louisiana Baptist Foundation – Estate planning, Gift Management, Fund Administration 
e. LA Baptist Federal Credit Union – available to all members of LA Baptist churches 

3. GoServeLA – LA resumé services website for both churches and ministerial staff  
4. SBC.net – site of the national Southern Baptist Convention.  Additional links to various Baptist 

ministries, entities, or topics that can be found at the bottom of page at this site. 
a. SBC Executive Committee 
b. SBC Entities & Seminaries 
c. SBC Calendar  
d. Baptist Press 

 
 

Links for Information, statistics, and software training, reviews, discounts: 

5. ChristianityToday site for churches called Church Law and Tax.  Has a wealth of information that 
is intended to assist churches on topics from legal to social matters. 

6. DataReportal – annual statical impact of the internet and social media impact. 
7. Lantec – LA based online training for software, management, programming. (Course offerings) 
8. Software review sites or discount purchase sites. 

a. Capterra – reviews, ratings, comparison of all types of software 
b. CCB Technology – get pricing for non-profits on software and some hardware. 

i. Microsoft.com – get Microsoft 365 Business Premium offers a grant for ten free user 
licenses (strict 501c3 accredited enforcement) 

c. Techsoup.org – nonprofit tech marketplace-offers discounts and specials. 
 

Links for software: 

9. Calendaring/Scheduling software: 
a. Monday.com 
b. Connecteam 
c. SimplyBook.me 
d. Wrike 
e. Homebase 
f. Visual Planning 

Note: If you use Microsoft 365 or Google Workspace, both offer in app calendaring/scheduling capabilities and will 

tie in with your work environment. 

10. Free Graphic Design and Publishing applications (good for newsletters, flyers, logos, etc.) 
a. Canva – both free and paid versions.  If you submit 501c3 certification to prove nonprofit 

status you get the Pro version for free. 
b. Adobe Express – free or paid Premium versions. 

  

http://www.laone.org/
https://louisianabaptists.org/
https://louisianabaptists.org/resources/ministries/
https://talltimbersbcc.org/
https://www.baptistmessage.com/
https://lbfinfo.org/
https://labaptistfcu.com/
https://www.goservela.org/
sbc.net
https://www.sbc.net/about/what-we-do/sbc-entities/executive-committee/
https://www.sbc.net/about/what-we-do/sbc-entities/
http://www.sbc.net/calendar
https://baptistpress.com/
https://www.christianitytoday.com/
https://www.churchlawandtax.com/
https://datareportal.com/
https://lantecctc.com/
https://lantecctc.com/CourseOfferings
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/capterra.com
https://ccbtechnology.com/
https://www.microsoft.com/en-us/microsoft-365/nonprofit/plans-and-pricing?activetab=tab%3aprimaryr1
https://www.techsoup.org/
monday.com
https://connecteam.com/
https://simplybook.me/en/
https://www.wrike.com/vv/
https://joinhomebase.com/
https://visual-planning.us/
https://www.canva.com/
https://www.adobe.com/express/


 
 Website Resources 

 

11. Accounting Software - Forbes 2023 Best: (**Capterra’s best church accounting software list) 
a. Aplos** – best overall (by ACS Technologies) 
b. Intuit QuickBooks** – best for nonprofit cash flow management 
c. Wave Accounting** – best for free basic accounting tools 
d. FreshBooks – best for expense tracking and management 
e. Xero** – best for in-depth and customizable reporting 
f. Zoho Books – best for automations 

g. Realm** – best for easy church donation management (by ACS Technologies) 
h. Quicken** – best for volunteer-run nonprofits. 
i. NetSuite – best for tailored accounting software 
j. Sage Intacct** – best for managing large, global nonprofit financials. 

 
12. Church Management software from Capterra shortlist:  

a. Breeze 
b. Chmeetings 
c. ChurchTrac 
d. SimpleChurch CRM 
e. Church Management Windows  
f. PowerChurchPlus 
g. FellowshipOne 
h. Realm 
i. Aplos 
j. Tithe.ly 

 
13. Security based websites-services-tools 

a. Avast – anti-virus software. 
b. Windows Defender – anti-virus software; anti-spam 
c. Norton – anti-virus software 
d. McAfee – anti-virus software 
e. Barracuda – anti-spam software; phishing protection 
f. KnowBe4 security training tool for staff that trains how to avoid phishing. 
g. Ninite – updating software that skips ‘add on’ software installation, less opportunity for 

installing Malware. 
 

14. Password Managers 
a. LastPass  
b. 1Password 
c. Bitwarden  
d. Keeper  
e. Norton  

 
15. Parental control software 

a. Covenant Eyes  
b. Qustodio  
c. Circle Home Plus  
d. Norton Family  

 

*Note: There are two obvious omissions from this list – Microsoft 365 and Google Suites.  Those are both great 

tools and are capable of many of the software options here.  This list is not meant to serve as a complete listing or 

as a recommendation but simply a list of products either mentioned during training or referenced in research. It is 

recommended that you explore and review any product you want to invest in/purchase.  You are the best judge of 

what will work for your situation. 

https://www.aplos.com/
https://quickbooks.intuit.com/
https://www.waveapps.com/
https://www.freshbooks.com/
https://www.xero.com/
https://www.zoho.com/us/books/
https://www.acstechnologies.com/realm/
https://www.quicken.com/
https://www.netsuite.com/portal/home.shtml
https://www.sage.com/en-us/
https://www.breezechms.com/
https://www.chmeetings.com/
https://www.churchtrac.com/
https://www.simplechurchcrm.com/
https://churchwindows.com/
https://www.powerchurch.com/products/pcplus/
https://www.fellowshipone.com/
https://www.acstechnologies.com/realm/
https://www.aplos.com/
https://get.tithe.ly/lp/giving-platform?wickedsource=google&wickedid=CjwKCAjw6IiiBhAOEiwALNqncePT1W5dr02SK9V5c_x7QX1LIMpePWSU4eGDOLVJLVd5Cd8QOd_E3xoCub0QAvD_BwE&wickedid=415320866851&wcid=19647353230&wv=4&utm_term=tithely&utm_campaign=PSA+%7C+Brand+%7C+Global+%7C+Exact&utm_source=adwords&utm_medium=ppc&hsa_acc=8428594682&hsa_cam=19647353230&hsa_grp=146920958618&hsa_ad=415320866851&hsa_src=g&hsa_tgt=kwd-295895020540&hsa_kw=tithely&hsa_mt=e&hsa_net=adwords&hsa_ver=3&gclid=CjwKCAjw6IiiBhAOEiwALNqncePT1W5dr02SK9V5c_x7QX1LIMpePWSU4eGDOLVJLVd5Cd8QOd_E3xoCub0QAvD_BwE
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/avast.com
http://www.microsoft.com/en-us/windows/comprehensive-security
http://www.norton.com/
http://www.mcafee.com/
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/e.%09Barracuda
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/knowbe4.com
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/ninite.com
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/lastpass.com
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/1password.com
https://louisianabaptists-my.sharepoint.com/personal/shana_johnson_lbc_org/Documents/Shana-OD/Documentation/Training/2023%20LABMA/bitwarden.com
https://www.keepersecurity.com/affiliate/keeper-50off-unlimited.html?LSNSUBSITE=Omitted_%2F0ACm*g5rXE
https://my.norton.com/extspa/passwordmanager?inid=nortoncom-overview_card22_mynorton
http://www.covenanteyes.com/
http://www.qustodio.com/
https://meetcircle.com/
https://us.norton.com/products/norton-family?SID=05SDHd593vxOjKLUtPQqjEH&cjid=5226272&clickid=7f8836ebdfbc11ed8104ae430a1cb82a&af_sub4=aff&af_sub5=CJ&c=CJ&cjevent=7f8836ebdfbc11ed8104ae430a1cb82a


The guidelines below give retention periods for the most common records.

ACCOUNTING RECORDS RETENTION PERIOD

Accounts payable 7 years

Accounts receivable 7 years

Audit Reports Permanent

Chart of Accounts Permanent

Contribution records 7 years

Depreciation schedules Permanent

Expenses records 7 years

Financial statements (annual) Permanent

Fixed asset purchases Permanent

General Ledger Permanent

Loan payment schedules 7 years

Form 1099-MISC 7 years

BANK RECORDS

Bank reconciliations 2 years

Bank statements 7 years

Canceled checks 7 years

Electronic payment records 7 years

CORPORATE RECORDS

Board Minutes Permanent

Bylaws Permanent

Business licenses Permanent

Contracts – major Life + 4 years

Contracts – minor Life + 3 years

Insurance policies Permanent

Leases/mortgages Permanent

Patents/trademarks Permanent

Form 990-T 7 years

Form 5578 (nondiscrimination) 7 years

EMPLOYEE RECORDS

Benefit plans Permanent

Employee files (ex-employees) 7 years

Employment applications (ex-employees) 3 years

Employment taxes 7 years

Payroll records 7 years

Retirement plans Permanent

Form W-2, W-4, 941 7 years

Time Sheets/Leave Requests 3 years

REAL PROPERTY RECORDS

Construction records Permanent

Leasehold improvements Permanent

Lease payment records Life + 4 years

Real estate purchases Permanent

        RECORD RETENTION GUIDE



All Official Records Photographs

Church minutes including minutes of staff, Church members and building

committees, deacons, WMU, etc. Special celebrations

Legal papers (deeds, trust agreements)

Taxes (federal, property, state) Biographical Information

Financial records (audit reports, payroll Church leaders: Pastors, Music & Education 

records, general ledgers, journals) directors and church leaders

Members

Speeches & Presentations

Final drafts of sermons, special Memorabilia

presentations, etc. Plaques and trophies

   Communion ware

Publications (only one each) Diaries and scrapbooks

Newsletters

Worship bulletins Unofficial Correspondence

Membership directories, brochures and Birthday cards

pamphlets published by the church Invitations

Birth/death announcements

Histories

Written Newspaper Clippings

Oral (recorded & transcribed) Church  

Recordings of services or special events Church members

2 to 3 years: 6 to 7 years:

     Bank statements      Bonds, registers & cancelled

     General correspondence      Expired contracts & agreements

     Voided payroll checks      Employee records (terminated)

     Delivery receipts      Federal/state income tax returns

     Insurance, group disability, etc.

3 to 4 years:      Invoices, paid

     Deposit slips      Payroll, general, part-time, over-time

     Expired insurance policies, all types      Real estate records (after disposal of 

     Requisitions & purchase orders           Land and buildings)

4 to 5 years: 7 to 8 years:

     Correspondence with applicants      Checks, payroll

     Employees’ applications (terminated)      Purchase orders for capital expenditure

     Tax with holding statements

8 to 9 years:

5 to 6 years:      Accident reports (after settlement)

     Equipment inventory records      Agreements, leases (after expiration)

     Safety, insurance, fire inspection reports      Checks, general & petty cash

     Internal audit reports      Compensation cases (after closing)

     Monthly trial balances      Vouchers, cash & numeric copy

     Photographs of installations, etc.

January 2017 – as researched by Archivist, Karon McCartney

           From the Archives of Louisiana Baptists

SUGGESTED RECORD RETENTION

CLASSIFICATION OF DOCUMENTS



 

 

 

 

 

 

 

Be Careful How You Walk 
 

Therefore, be careful how you walk, not as unwise men, 

but as wise.          Ephesians 5:15 
 

Six Characteristics of a Spirit Filled Life 

1. Holy speech 

2. Joyful heart of worship 

3. Thankful disposition  

4. Honors the name of Jesus Christ 

5. Mutual submission (unity) 

6. Reverence for God 
 

Eight guidelines for walking Spirit Filled in Social Media Participation 

1. Does this decision BEST glorify God? 

2. Could this cause my brother to stumble? 

3. Could what I say be misunderstood or misinterpreted? 

4. Does this post/pic portray genuine holiness? 

5. Can I take these words/pictures back? 

6. A Christian is NEVER “off duty” 

7. Online “friends” are NOT true relationships. 

8. How will this affect my reputation? Family, church, God? 
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